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FOREWORD

The results presented in this report are part of the Office
of Naval Technology's (Code ONT-227) Engineering of Complex
Systems (ECS) Technology Block effort. The ECS block was
developed to integrate system engineering capabilities for
developing large-scale, real-time, computer intensive systems.
The goal of the block is to improve the way in which the Navy
currently creates, maintains, and improves systems by
incorporating state-of-the-art technology and supplying new
technology where holes in present methods exist. The block is
divided into four projects: Systems Design Synthesis Technology
(RS34P11), Systems Evaluation and Assessment Technology
(RS34P12), Systems Reengineering Technology (RS34PI3), and
Engineering Application Prototypes (RS34P14). These projects
work closely together to incorporate new technology across the
entire system development life cycle.

The System Design Structuring and Allocation Optimization
(DESTINATION) task is one of the efforts within the System Design
Synthesis Project. The goal of this task is to research,
develop, and prototype methodology for optimizing the design of
large, complex, real-time systems in a distributed and parallel
processing environment. This optimization is performed within
the context of design structuring, restructuring, and allocating
functional models to resource models to satisfy the desirable
measures of effectiveness.

The DESTINATION prototype Level I is a collaborative effort
divided among the tasks within the System Design Synthesis
Project and among government, business, and academia (including
the Naval Surface Warfare Center, Naval Air Warfare Center,
Computer Command and Control Company, Trident Systems
Incorporated, and University of Illinois).

The DESTINATION Prototype Level I User's Manual is one of
the products of the DESTINATION task. The objective of this
manual is to help the systems engineers and systems analysts use
this prototype. This prototype will continue to be developed.
The planned development will include refinement, enhancement, and
the incorporation of advanced features through Level III.
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ABSTRACT

The objective of the System Design Structuring and
Allocation Optimization (DESTINATION) Prototype Level I User's
Manual is to help the systems engineers and systems analysts use
the DESTINATION prototype Level I effectively. This manual
specifies the system's installation requirements, describes the
installation procedure, explains each of the menus and commands
in the prototype and how to use specific menus and commands; it
also gives troubleshooting procedures for handling error
messages.
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CHAPTER 1

INTRODUCTION

The objective of the System Design Structuring and
Allocation Optimization (DESTINATION) task is to research,
develop, and prototype a methodology for optimizing the design of
large, complex, real-time systems in a distributed and parallel
processing environment. This optimization is performed within
the context of design structuring, restructuring, and allocating
functional models to resource models to meet the system measures
of effectiveness.

The concept and methodology portion of the DESTINATION task
is described in The DESTINATION Methodology and Capabilities,
NSWCDD/TR-92/374 (in publication). Please refer to that report
for a detailed description. This user manual will only help the
systems engineers and systems analysts use the DESTINATION
prototype Level I.

The remainder of this manual is organized as follows:
Chapter 2, "DESTINATION Usage," provides installation
instructions, descriptions for each of the menus and commands in
the prototype, and a guide for the use of specific menus and
commands. Chapter 3, "Current Status," provides progress
information. Chapter 4, "Future Plans and Directions," describes
ongoing research.

If there are any questions on the use of this prototype,
please contact:

Cuong M. Nguyen
Code B44
Naval Surface Warfare Center
10901 New Hampshire Avenue
Silver Spring, MD 20903-5640
TEL: (301)394-4550
FAX: (301)394-1175
EMAIL: cnguyen@relay.nswc.navy.mil
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CHAPTER 2

DESTINATION USAGE

This chapter provides installation instructions and
descriptions for each of the menus and commands in the prototype
and guides the user through specific menus and commands.

2.1 INSTALLATION ENVIRONMENT REQUIREMENTS

In order to run the DESTINATION prototype Level I version
0.5, the user's environment is required to have the following
hardware, software, and operating system:

"* Platform: Sun4, Sparc I or later
"* Operating System: Unix Version 4.1.1
"* Application Software:

X Window Version XlIR4
Motif Version 1.1
EPOCH Version 3.2.1

If the environment meets the above requirements, the user
performs the following steps to install the DESTINATION tape:
(No special procedures are involved except to load the binary
file into the directory where the user wants to store the
DESTINATION Level I prototype.)

Step 1. Moves to the location where DESTINATION is to be
stored.
Example: cd /home/trinh/DESTLlVO1

Step 2. Copies the DESTINATION files from the given tape
to the current directory as follows:
tar xvf /dev/rstO

Step 3. Inserts a set-environmental command in the user's
".login" file.
setenv WD Pathway-of-DESTINATION (e.g., setenv WD
/home/trinh/DESLlVOl), where pathway-of-
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DESTINATION is the complete pathway from the root
directory to the directory where the DESTINATION
executable file exists.

Step 4. Updates the ".login" file by issuing the source
command as follows:
source .login

2.2 RUNNING THE DESTINATION PROTOTYPE

To run the DESTINATION prototype, the user goes to the
directory where the user has stored it (e.g., cd
/home/trinh/DESLlVO1), then types:

DESTINATION LIV01 <CR>

The main SYNTHESIS window (Figure 2-1) appears on the
screen. It consists of the following pulldown menus: File, Edit,
Scenario, Arrange, Utilities, Tutorial, Help, Synthesis
Workbench, Design Factors, Model Selection, Extent Selection,
Preferences, System Engineering Activity, Resource Allocation
Optimization, Design Structuring Optimization, and Optimization
Manager. These pulldown menus and their commands are described
in the following sections.

2.3 USING COMMANDS FROM THE DESTINATION SYNTHESIS MENU

This section describes how to use commands from the
DESTINATION Synthesis menu to optimize the design structure and
generate a near-optimal allocation of the logical systems
functions onto the implementation resources to meet the overall
system requirements.

The user is restricted to selecting the (System Engineering
Activity] pulldown menu as the first step of operating the
SYNTHESIS window. If another button is selected before the
[System Engineering Activity] pulldown menu, the selected button
will not be activated and the message "This button is not
activated unless you select the button [System Engineering
Activity] first!" will appear in the "Message" box (see
Figure 2-1). This message is acknowledged by clicking on the
button [OK] of the "Message" box before proceeding.

2.3.1 System Engineering Activity Pulldown Menu

The [System Engineering Activity] (SEA) pulldown menu is
meant for guiding the systems engineer or the user throughout
various phases of system engineering. By selecting a certain
phase, the user can only perform or execute the functions within
it.

2-2
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The [System Engineering Activity) pulldown menu consists of
the following commands: Requirement, Specify, Capture, Analyze,
Design, Simulate, Optimize, Evaluate, Configuration Management,
Validation, Verification, Test, and Other. Each of these
commands represents a different phase of the system engineering
life cycle. When a command is activated, it will allow only a
certain operation during that phase to be performed. The
commands in this pulldown menu are used both to guide the user
throughout the whole system engineering process and
simultaneously manage the networking file system for the whole
development team.

Any selection of the SEA phase except "Other" will force the
user to perform the operation within that selected SEA phase; and
any file created within a SEA phase will have a file extension
that corresponds to the SEA phase in which it is created. Later,
if the user would like to change from one SEA phase to another or
from one file extension to another, the user must go back to the
[System Engineering Activity] pulldown menu and reselect phase
"Other".

The exact capabilities allowed within each phase will be

defined in a future versior of the user's manual.

Requirement Command

This command limits the user to the requirements operation
during this phase. It is activated by selecting the
[Requirement] menu item from the [System Engineering Activity]
pulldown menu.

Specify Command

This command limits the user to the specification operation
during this phase. It is activated by selecting the [Specify]
menu item from the [System Engineering Activity] pulldown menu.

Capture Command

This command limits the user to the capture operation during
this phase. It is activated by selecting the [Capture] menu item
from the [System Engineering Activity] pulldown menu.

Analyze Command

This command limits the user to the analyze operation during
this phase. It is activated by selecting the [Analyze] menu item
from the [System Engineering Activity] pulldown menu.

DesiQn Command

This command limits the user to the design operation during
this phase. It is activated by selecting the [Design] menu item
from the [System Engineering Activity] pulldown menu.
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Limulate Command

This command limits the user to the simulate operation
during this phase. It is activated by selecting the [Simulate]
menu item from the [System Engineering Activity] pulldown menu.

Optimize Command

This command limits the user to the optimize operation
during this phase. It is activated by selecting the [Optimize]
menu item from the [System Engineering Activity] pulldown menu.

Evaluate Command

This command limits the user to the evaluate operation
during this phase. It is activated by selecting the [Evaluate]
menu item from the [System Engineering Activity] pulldown menu.

Configuration Management Command

This command activates a cascade menu with a list of
commands to manage the configuration of different types of files
during this system development cycle. It is activated by
selecting the [Configuration Management) menu item from the
[System Engineering Activity] pulldown menu.

Validation Command

This command limits the user to the validation operation
during this phase. It is activated by selecting the [Validation]
menu item from the [System Engineering Activity] pulldown menu.

Verification Command

This command limits the user to the verification operation
during this phase. It is activated by selecting the
[Verification] menu item from the [System Engineering Activity]
pulldown menu.

Test Command

This command limits the user to the test operation during
this phase. It is activated by selecting the [Test] menu item
from the [Systen Engineering Activity] pulldown menu.

Other Command

This command allows the user to use any operation. It is
activated by selecting the [Other] menu item from the [System
Engineering Activity] pulldown menu.

2.3.2 File Pulldown Menu

The [File] pulldown menu provides commands and utilities for
file manipulation. It consists of the following commands: New,
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Open, Save, Save As, Rename, Copy, Create Directory, Delete
Directory, Print, Delete File, Import, Export, Close, and Quit.

New Command

The command New creates and then opens a new file.

This command is activated by selecting the menu item [New]
from the [File] pulldown menu. When this command is activated, a
small rectangular outline appears, waiting for the user to click
on it. The outline then becomes a solid window with the title
"Minibuffer," called the MINIBUFFER window (see Figure 2-2).
Below the title bar is a command line that shows the status of
the interactive commands and messages and also prompts the user
for input and confirmation. For this case, the message is "(New
file)." Another larger rectangular outline appears, waiting for
the user to click on it. This outline then becomes a solid
window with the title "scratch," called the EDITOR window (see
Figure 2-2). Below the title bar are work spaces for the user to
enter the content of the new file.

R) *scratch* @ wanda

[E Minlbuffer@wanda
(NW file)

FIGURE 2-2. EDITOR WINDOW AND MINIBUFFER WINDOW

Open Command

The command Open allows the user to open an existing file.

Once the user moves the mouse cursor to the (File] pulldown
menu and selects the menu item [Open], the "File and Directory"
dialog box appears (see Figure 2-3). The dialog box consists of
the following items: (1) the box title "File and Directory," (2)
a text label line for displaying messages which, for this case,
is "EDIT AN EXISTING FILE," (3) three key-in boxes: path name,
file name, and file extension, (4) scroll bars, (5) two scroll
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selection lists: files and directories, and (6) two push buttons:
[OK] and [QUIT].

By default, the key-in box "Path" displays the pathway-of-
DESTINATION; the key-in box "File" displays "*" for all files;
the key-in box "Extension" displays the extension that
corresponds to the selected SEA phase; the Files scroll list
displays all the files that are located in the default path and
also have the default extension; and, finally, the Directories
scroll list displays the current directory (./), the parent
directory (../), and all the subdirectories under the default
path.

R, File and Directory

EOIT AN EXISTING FILE.

PATH: I

FMLE DUMCTORM1

D0_SYRPRO10_~z ij

Iaak&Ll'vW mLcO!.W

lM&kA11VM_3DIA2PP
ImAk,.L1V•I .•.P.,

OK QUT

FIGURE 2-3. DEFAULT OF THE "FILE AND DIRECTORY" DIALOG BOX

The user can change the directory either by selecting the
new directory name from the Directories scroll list or by editing
the key-in box "Path" (see Figure 2-4). However, if the
directory is reversed with the intention to pass the root, the
message "Sorry, you cannot pass root of the path!" will appear in
the "Message" box. This message is acknowledged by clicking on
the button (OK] of the "Message" box. The key-in box "File" can
also be edited (see Figure 2-4). Any selection of the SEA phase,
besides phase "Other," forces the user to perform the operation
within that selected SEA phase. Therefore, when the user changes
the key-in box "Extension," the "Message" box--with the message
"Sorry, you cannot change value of the extension!"--will appear.
Again, the "Message" box can be destroyed by clicking on its
button [OK]. In order to edit the key-in box "Extension," the
user must reselect SEA phase "Other" from the [System Engineering
Activity] pulldown menu.

2-7



NSWCDD/TR-92/372

(E File and Directory

EDIT AN EXISTING FILE.

PAM: ,

FILE DtRECIMR!E

S~I

oK _ Qurr

FIGURE 2-4. THE "FILE AND DIRECTORY" DIALOG BOX AFTER A CHANGE
BY THE USER

A file to be edited is selected either by entering the
filename in the key-in boxes "File" and "Extension" or by
choosing a filename from the Files scroll list. Once the file
has been selected, the user should click on the button [OK] of
the "File and Directory" dialog box. This results in the
disappearance of the dialog box. As with the command New, the
MINIBUFFER window and the EDITOR window will appear, allowing the
user to view or edit the file.

Save Command

The command Save saves the newer version of an existing text
file, with the original name the user gave it, and puts it
exactly where it came from when the user opened it. The user
should use the command Save rather than the command Save As for
routine, periodic saving of a text file.

When the text of an existing file is edited in the EDITOR
window, the user selects the menu item [Save] from the [File]
pulldown menu. The command line of the MINIBUFFER window will
show "Wrote" and the current full pathname and filename.

If, after entering a new text file in the EDITOR window, the
user selects the menu item [Save] (instead of the menu item [Save
As]) from the [File] pulldown menu by accidenft, the system will
save the new file under the name "scratch." It is strongly
recommended that the user rename this file.
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Save As Command

The command Save As allows the user to save the text of a
new file or an existing file with a new name.

When the text of a new file is entered or the text of an
existing file is edited in the EDITOR window, the user selects
the menu item [Save As] from the [File] pulldown menu. The
command line of the MINIBUFFER window will show "Write file:" and
the current full pathname, waiting for the user to edit the
desired pathname and the new filename. Once the full pathname
and new filename have been entered, the user hits [RETURN] to
execute the command.

Rename Command

The command Rename allows the user to rename a file.

After the user moves the mouse cursor to the [File] pulldown
menu and selects the menu item [Rename], the "File and Directory"
dialog box appears. The description of the "File and Directory"
dialog box and its mechanism of operation can be found in
subsection "Open" of Section 2.3.2. The user selects a file in
any directory to be renamed and then clicks on the button (OK].
This results in the appearance of the "Confirmation" box, which
prompts the user for the new filename (see Figure 2-5). Once the
new filename has been entered, the user executes the command by
clicking on the button [OK] of the "Confirmation" box and leaves
the "Confirmation" box by hitting its button (QUIT].

ffJ File and Dlrectoiy

RENAME A FILE.

Confinulson I PAIe :

Please enter the newi file-name:

-, J

OK QWz

OK Qt"

FIGURE 2-5. THE "FILE AND DIRECTORY" DIALOG BOX AND THE
"CONFIRMATION" BOX FOR THE COMMAND Rename
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The displayed "File and Directory" dialog box can be used to
check whether the command operated correctly. The user can
select another file in any directory and rename or leave the
"File and Directory" dialog box by clicking on its button [QUIT].

Copy Command

The command Copy allows the user to copy one or more files
from one directory to another directory.

When the menu item [Copy] is selected from the [File]
pulldown menu, the "Source and Destination" dialog box with
default information appears (see Figure 2-6). Note that the
construction of the "Source and Destination" dialog box is based
on that of the "File and Directory" dialog box. Therefore, for
more information on the description of the "File and Directory"
dialog box and its mechanism of operation, see subsection "Open"
of Section 2.3.2.

N[- Fle and Directory

COPY FILE(S) FRON. COPY FILE(S) TO.

PHI:
D3P/r14 PAN:0, J l ,_

MD-IF E~I FWl - -

DFM .tIO~ DMIOP "yM

ina.uvol row:_P

FOR THE COMMAND Copy

The "Source and Destination" dialog box contains two parts:
the source information on the left side and the dest.•nation
information on the rightý side. On the source part, the user
selects one or more files in the desired directory, then clicks
on the button [OK] for the source inf- .nmation to be acknowledged
and for the destination information to be set to default. On the
destination part, the user selects the desired directory, then
clicks on the button [OK]. This results in the following
sequence: (1) the destination information being acknowledged,
(2) the command Copy being executed, (3) all files in that
directory being displayed for checking purposes, and (4) the

2-10



NSWCDD/TR-92/372

source information being set to default, allowing the user to
select other files to copy.

There is a small change in operating the destination part if
the user wishes to copy a file under a different name: the user
selects the desired directory, types in the new filename and its
new extension, and then clicks on the button [OK] (see
Figure 2-7).

ffl File and Directory P1

COPY FILE(S) TO. COPY FILE(S) TO.

PATH: I PAMH:

F=L U~TN FMf DUCIMCOE

S1 I

DUYNFD100I.S J J)IB.PU o~om. , .Js

h.,W&L1VM3DWNF P

tMA"et 3MiX P,

oM i oci ,"

FIGURE 2-7. THE "SOURCE AND DESTINATION" DIALOG BOX WHEN COPYING

A FILE UNDER A DIFFERENT NAME

Create Directory Command

The command Create Directory allows the user to create a new
subdirectory.

Once the user moves the mouse cursor to the [File] pulldown
menu and selects the menu item [Create Directory], the "File and
Directory" dialog box appears. The description of the "File and
Directory" dialog box and its mechanism of operation can be found
in subsection "Open" of Section 2.3.2. The user selects a
directory to create its new subdirectory and then clicks on the
button [OK]. This results in the appearance of the
"Confirmation" box which prompts the user for the new
subdirectory name. Once the new subdirectory name has been
entered, the user executes the command by clicking on the button
[OK] of the "Confirmation" box and leaves the "Confirmation" box
by hitting its button [QUIT].

The displayed "File and Directory" dialog box can be used to
check whether the command operated correctly. The user can
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select another directory to create its new subdirectory or leave
the "File and Directory" dialog box by clicking on its button
[QUIT].

Delete Directory Command

The command Delete Directory allows the user to delete a
directory.

When the menu item (Delete Directory] is selected from the
[File] pulldown menu, the "File and Directory" dialog box
appears. The description of the "File and Directory" dialog box
and its mechanism of operation can be found in subsection "Open"
of Section 2.3.2. The user selects the directory to be deleted
and then clicks on the button [OK]. This results in the
appearance of the "Confirmation" box, which confirms the deletion
of the to-be-deleted directory (see Figure 2-8). The user
executes the command by clicking on the button [OK] of the
"Confirmation" box and leaves the "Confirmation" box by hitting
its button [QUIT].

The key-in box "Path" of the displayed "File and Directory"
dialog box can be edited to check whether the command operated
correctly. The user can select another directory to delete or
leave the "File and Directory" dialog box by clicking on its
button [QUIT].

g File and Diletory

DELETE DIRECTORY.

R Conflmnatlon ED m: PAU:

Are you sure you want to delete FM: I~
this directory?

FIaE DMECTOR2

OK -QTi

FIGURE 2-8. THE "FILE AND DIRECTORY" DIALOG BOX AND THE

"CONFIRMATION" BOX FOR THE COMMAND Delete Directory

Print Command

The command Print allows the user to print one or more
files.
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After the user moves the mouse cursor to the [File] pulldown
menu and selects the menu item [Print], the "File and Directory"
dialog box appears. The description of the "File and Directory"
dialog box and its mechanism of operation can be found in
subsection "Open" of Section 2.3.2. After selecting a file or a
group of files in any directory to be printed, the user clicks on
the button [OK] to execute the command. The user can select
other files in other directories to print or leave the "File and
Directory" dialog box by clicking on its button [QUIT].

Delete File Command

The command Delete File allows the user to delete one or
more files.

When the menu item [Delete File] is selected from the [File]
pulldown menu, the "File and Directory" dialog box appears. The
description of the "File and Directory" dialog box and its
mechanism of operation can be found in subsection "Open" of
Section 2.3.2. After selecting a file or a group of files in any
directory to be deleted, the user clicks on the button [OK].
This results in the appearance of the "Confirmation" box, which
confirms the deletion of the to-be-deleted file(s). The user
executes the command by clicking on the button [OK] of the
"Confirmation" box and leaves the "Confirmation" box by hitting
its button [QUIT].

The key-in box "File" of the displayed "File and Directory"
dialog box can be edited to check whether the command operated
correctly. The user can select other files in other directories
to delete or leave the "File and Directory" dialog box by
clicking on its button [QUIT].

Import Command

The command Import allows the systems engineer to import a
model captured from a commercial CASE tool and simulation tool to
the DESTINATION prototype for the optimization. Currently,
initial Import capabilities from the Teamwork CASE tool to the
DESTINATION prototype have been implemented.

Export Command

The command Export allows the systems engineer to export a
model optimized from the DESTINATION prototype to a commercial
CASE tool and simulation tool. Currently, this command has not
been implemented.

Close Command

The command Close closes the text file that the user has
viewed or edited in the EDITOR window and then destroys the
MINIBUFFER window and the EDITOR window.
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In general, after using the command Save or Save As, the
user moves the mouse cursor to the [File] pulldown menu and
selects the menu item [Cl se]. This results in the disappearance
of the MINIBUFFER window and the EDITOR window.

The user can also select the menu item [Close] without
having to use either the command Save or Save As. In other
words, the menu item [Close] can be selected when the user only
needs to view the text (after using command Open) or when the
user decides neither to save the new text file that has been
entered (after using command New) nor to save the new version of
the text file that has been edited (after using command Open).

In this special case, after using the command New or Open,
the user moves the mouse cursor to the [File] pulldown menu and
selects the menu item [Close]. The command line of the
MINIBUFFER window will show: "Save file," the current full
pathname, the filename (if the user is in New mode, the filename
will be "scratch"), and "? (y or n)" (see Figure 2-9). To enter
"n," the user must move the mouse cursor into either the
MINIBUFFER window or the EDITOR window. The command line of the
MINIBUFFER window shows: "i mociified buffer exists, do you really
want to exit? (yes or no)." Again the user moves the mouse
cursor into either the MINIBUFFER window or the EDITOR window in
order to enter "yes." This results in the disappearance of the
MINIBUFFER window and the EDITOR window. Although the user did
not save the text before closing the text, the text will still
automatically be saved in the buffer with the new filename formed
by enclosing the current filename by the character "#."
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FIGURE 2-9. EDITOR WINDOW AND MINIBUFFER WINDOW FOR THE COMMAND
Close (WITHOUT EITHER Save OR Save As)

2-14



NSWCDD/TR-92/372

Quit Command

The command Quit allows the user to leave the application
software DESTINATION.

When the user moves the mouse cursor to the [File] pulldown
menu and selects the menu item [Quit], the whole application
software DESTINATION will stop executing and all DESTINATION
windows will be closed.

2.3.3 Edit Pulldown Menu

The [Edit] pulldown menu provides the capability to
manipulate the contents of a file.

When the [Edit] pulldown menu is selected from the SYNTHESIS
window, a list of commands will appear. They are Undo, Redo,
Cut, Copy, Paste, Clear, Duplicate, Select All, Font, and Style.

Undo Command

The command Undo undoes the last text-editing action on a
file buffer when the user makes a mistake or changes his mind
about some action. Currently, this command has not been
implemented.

Redo Command

The command Redo redoes the last text-editing action on a
file buffer. Currently, this command has not been implemented.

Cut Command

The command Cut removes the selected text from the file
buffer and places the text on the cut/paste buffer either to be
inserted into the file elsewhere or to be deleted.

In order to use the command Cut, the text needs to be
marked. The user can mark the text by first placing the pointer
on the first character of the text. Then the text is underlined
by pressing and holding the left button of the mouse until the
text needed to be cut has been marked. Once the text has been
marked, the user will move the mouse cursor to the [Edit]
pulldown menu and will select the menu item [Cut]. This results
in the marked text being removed from the file buffer and being
placed into the cut/paste buffer. Note that a Cut causes the
cut/paste buffer to be overwritten, thus deleting the prior
contents.

Copy Command

The command Copy copies the selected text from the file
buffer into the cut/paste buffer to be inserted into the file
elsewhere. The "original" stays where it was when the user
selected it.
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In order to use the command Copy, the text needs to be
marked. The user can mark the text by first placing the pointer
on the first character of the text. Then the text is underlined
by pressing and holding the left button of the mouse until the
text needed to be copied has been marked. Once the text has been
marked, the user will move the mouse cursor to the [Edit]
pulldown menu and will select the menu item [Copy]. This results
in the marked text being copied from the file buffer and being
placed into the cut/paste buffer. The command Copy overwrites
any text already in the cut/paste buffer.

Paste Command

The command Paste retrieves the text that has been stored in
the cut/paste buffer by the last Cut or Copy command.

After using the Cut or Copy command, the user moves the
cursor to the place where the text is to be retrieved and then
moves the mouse cursor to the [Edit] pulldown menu and selects
the menu item [(aste]. This command allows the user to continue
to retrieve text until the user cuts or copies a new selection
(which replaces the old contents of the cut/paste buffer).

Clear Command

The command Clear removes the selected text from the file
buffer without placing it on the cut/paste buffer. The contents
of the cut/paste buffer (if any) remain intact. Pressing the
Delete or Backspace key has the same effect as the command Clear.
Currently, this command has not been implemented.

Duplicate Command

The command Duplicate replicates the selected graphical
object(s) on the same window. This command can only replicate
whole objects. Currently, this command has not been implemented.

Select All Command

The command Select All selects all textual or graphical
objects in the active window. Currently, this command has not
been imnlemented.

Font Command

The command Font allows the user to set or change the look
of the text in the file buffer. Currently, this command has not
been implemented.

Style Command

The command Style allows the user to change the text from
one character style to a new style. Currently, this command has
not been implemented.
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2.3.4 Utilities Pulldown Menu

The [Utilities] pulldown menu provides the utilities to
interface with the X window system.

When the [Utilities) pulldown menu is selected from the
SYNTHESIS window, a list of commands will appear. They are
Refresh Screen, Reset, Console, Windowmgr, Print tool,
Administration, and Report Generation.

Refresh Screen Command

The command Refresh Screen allows the user to repaint all or
part of the screen.

After the user moves the mouse cursor to the [Utilities]
pulldown menu and selects the menu item [Refresh Screen], the
window manager will repaint windows on the screen.

Reset Command

The command Reset restores the terminal characteristics to
their default values.

When the manu item [Reset] is selected from the [Utilities]
pulldown menu, the window manager will clear all commands in
windows except the Console window.

Console Command

The command Console opens a new system Console window.

Once the user moves the mouse cursor to the [Utilities]
pulldown menu and selects the menu item [Console], a new system
Console window will be opened and raised to the top of the
screen.

Windowmgr Command

The command Windowmgr causes the Icon of the window manager
to pop up.

When the menu item [Windowmgr] is selected from the
[Utilities] pulldown menu, the Icon of the window manager will be
raised to the top of the screen.

Print Tool Command

The command Print tool brings up the OpenWindows' print
tool. This command will only work with the operating system of
Unix version 4.1. At this point, the application software TAE+
version 5.1 is running only on Unix version 4.0.3. Therefore,
this command will not work until TAE+ is updated.
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Administration Command

This command provides a cascade menu with a list of commands
to manage the programs, projects, personnel, privileges,
passwords, networking, databases, interfaces, records and logs,
versions, and other miscellaneous administrative functions. This
command is not yet available in this version.

Report Generation Command

This command provides a cascade menu with a list of commands
to customize the report format, and report manipulation such as
list report, merge report, sort report, generate report, bind
report, link report, generate program report, generate project
report, generate task report, generate component report, generate
log report, generate administration report, generate analysis
report, generate discrepancy report and generate error report.
This command is not yet available in this version.

2.3.5 Help Pulldown Menu

The [Help] pulldown menu provides help information about
DESTINATION and its commands. To get help, the user must click
on the [Help] pulldown menu from the SYNTHESIS window and a list
of help information will appear: About Destination, Index, and
Commands.

About Destination Command

The commanJ About Destination displays the help information
about the DESTINATION prototype Level I version 0.5 user manual.

After the user moves the mouse cursor to the [Help) pulldown
menu and selects the menu item [About Destination], the "Help"
box appears. The information on the command About Destination is
scrolled automatically and positioned at the first line of the
"Help" box. The ust-. can also scroll through the information in
the "Help" box as the user wishes. When the user is done with
the "Help" box, he closes it by pressing its button [OK].

Index Command

The command Index displays the index list of all the
commands used in DESTINATION (unstructured and alphabetical
commands; see Figure 2-10), which helps the user to understand a
particular command.

When the menu item [Index] is selected from the [Help]
pulldown menu, the "Index/Commands" box appears, allowing the
user to scroll through the commands in the Index list. After the
user selects a particular command for which the user wants help,
the "Help" box with help information appears. The information on
the command selected from the "Index/Commands" box is scrolled
automatically and positioned at the first line of the "Help" box
(see Figure 2-10). The user can also scroll through the
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information in the "Help" box as the user wishes. When the user
is finished with the "Help" box, he closes it by pressing its
button (OK] and then leaves the "Index/Commands" box by pressing
its button [CLOSE).
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Commands Command

The command Commands displays the list of all the commands
used in DESTINATION (structured commands; see Figure 2-11) and
then helps the user to understand a particular command.

After the user moves the mouse cursor to the [Help] puildown
menu and selects the menu item [Commands], the "Index/Commands"
box appears, allowing the user to scroll through the commands in
the Commands list. After the user selects a particular command
for which the user wants help, the "Help" box with help
information appears. The information on the command selected
from the "Index/Commands" box is scrolled automatically and
positioned at the first line of the "Help" box (see Figure 2-11).
The user can also scroll through the information in the "Help"
box as the user wishes. When the user is finished with the
"Help" box, it is closed by pressing its button [OK]. The
"Index/Commands" box is exited by pressing its button [CLOSE].
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2.3.6 Scenario Puildown Menu

The (Scenario] puildown menu provides a list of commands to
analyze, test, simulate, optimize, and evaluate the system under
design during various phases in batch mode and record the results
(statistical, deterministic, etc.) in a log file. It also stores
the states and the modes of the scenario session to allow
incremental analysis. The information collected by this pulldown
menu serves as the development life cycle bookkeeping of the
different components in different phases by different users. It
controls the networking file system for multi-user environment
interacting at different phases of the system development cycle.
This pulldown menu consists of the following commands:
Statistical Log, Create Scenario, Start/Pause/Continue scenario,
Stop Scenario, Save Scenario Mode, Save Scenario State, and
Display.

Statistical Logi Command

This command allows the user to save the statistical
analysis result in a file. It is activated by selecting the
[Statistical Log] menu item from the [Scenario] puildown menu.
This command is not yet available in this version.

Create Scenario Command

This command allows the user to create a file that contains

the list of the scenario language commands for batch run
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purposes. The scenario language commands contain a list of
timing control instructions. The command is activated by
selecting the (Create Scenario] menu item from the (Scenario]
pulldown menu. This command is not yet available in this
version.

Start/Pause/Continue Scenario Command

This command toggles among "start," "pause," and "continue"
for a specific scenario file. It is activated by selecting the
(Start/Pause/Continue Scenario] menu item from the [Scenario]
pulldown menu. This command is not yet available in this
version.

Stop Scenario Command

This command stops a specific scenario file. It is
activated by selecting the [Stop Scenario] menu item from the
[Scenario] pulldown menu. This command is not yet available in
this version.

Save Scenario Mode Command

This command stores the current mode of operation of a
specific scenario file that is active. This information is used
for analyzing the different modes of the system under design. It
is activated by selecting the [Save Scenario Mode] menu item from
the [Scenario] pulldown menu. This command is not yet available
in this version.

Save Scenario State Command

This command stores the current state of a specific active
scenario file. Its purpose is to incrementally analyze the
system under design. It is activated by selecting the [Save
Scenario State] menu item from the [Scenario] pulldown menu.
This command is not yet available in this version.

Display Scenario Command

This command displays the animation (or state by state) of a
specific scenario file that is active on the screen. It is
activated by selecting the [Display Scenario] menu item from the
[Scenario] pulldown menu. This command is not yet available in
this version.

2.3.7 Arrange Pulldown Menu

The [Arrange] pulldown menu provides a list of commands to
manipulate the textual and graphical objects during the design
that involves graphics. This pulldown menu consists of the
following commands: To Front, To Back, Forward One, Backward
One, Group, Ungroup, Align Center, Align Horizontal Center, Align
Vertical Center, Align Left, Align Right, Snap to Grid, and Grid
Setup.
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To Front Command

This command displays the selected object in front of all
objects in the current window. It is activated by selecting the
(To Front) menu item from the [Arrange] pulldown menu. This
command is not yet available in this version.

To Back Command

This command displays the selected object behind all objects
in the current window. It is activated by selecting the [To
back] menu item from the (Arrange] pulldown menu. This command is
not yet available in this version.

Forward One Command

This command displays the selected object in front of one
object in the current window. It is activated by selecting the
[Forward One] menu item from the [Arrange] pulldown menu. This
command is not yet available in this version.

Backward One Command

This command displays the selected object in back of one
object in the current window. It is activated by selecting the
[Backward One] menu item from the [Arrange] pulldown menu. This
command is not yet available in this version.

Group Command

This command merges the selected objects in the current
window into a group. It is activated by selecting the [Group]
menu item from the (Arrange] pulldown menu. This command is not
yet available in this version.

UnQroup Command

This command separates the selected group in the current
window into multiple objects. It is activated by selecting the
[Ungroup] menu item from the [Arrange] pulldown menu. This
command is not yet available in this version.

AliQn Horizontal Center Command

This command aligns the selected objects in the current
window to the center of the window horizontally. It is activated
by selecting the (Align Horizontal Center] menu item from the
(Arrange] pulldown menu. This command is not yet available in
this version.

Align Vertical Center Command

This command aligns the selected objects in the current
window to the center of the window vertically. It is activated
by selecting the [Align Vertical Center] menu item from the
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[Arrange] pulldown menu. This command is not yet available in
this version.

Align Left Command

This command aligns the selected objects to the left side in
the current window. It is activated by selecting the [Align
Left] menu item from the [Arrange] pulldown menu. This command
is not yet available in this version.

Align Right Command

This command aligns the selected objects to the right side
in the current window. It is activated by selecting the [Align
Right] menu item from the [Arrange] pulldown menu. This command
is not yet available in this version.

Snap to Grid Command

This command positions the selected objects to the nearest
grid mark in the current window. It is activated by selecting
the [Snap to Grid] menu item from the (Arrange] pulldown menu.
This command is not yet available in this version.

Grid Setup Command

This command partitions the grid spacing and activates or
deactivates the grid displayed in the current window. It is
activated by selecting the [Grid Setup) menu item from the
(Arrange] pulldown menu. This command is not yet available in
this version.

2.3.8 Tutorial Pulldown Menu

This pulldown menu provides a list of commands to give
tutorials on various parts of the DESTINATION prototype. It
includes some of the commercial-off-the-shelf (COTS) tools and
government-off-the-shelf (GOTS) tools. This pulldown menu
consists of the followiý,Ic commands: Navigation, DESTINATION,
Design Optimization, Resre[rce Allocation, Optimization Manager,
Respect, Mimne, Depend, Teamwork, STP, SES, ADAS, ARM, PERTS,
Network 11.5, and Comet.

Navigation Command

This command walks the user through the tutorial on the
Navigation prototype. The Navigation is a prototype that will be
developed by the Real-time System Design Capture and Analysis
effort in the ECS program. It is activated by selecting the
[Navigation] menu item from the [Tutorial] pulldown menu. This
command is not yet available in this version.
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DESTINATION Command

This command walks the user through the tutorial for this
prototype. It is activated by selecting the [DESTINATION] menu
item from the [Tutorial] pulldown menu. This command is not yet
available in this version.

Design Optimization Command

This command walks the user through the tutorial on the
Design Optimization Capabilities of this prototype. It is
activated by selecting the [Design Optimization] menu item from
the [Tutorial] pulldown menu. This command is not yet available
in this version.

Resource Allocation Command

This command walks the user through the tutorial on the
Resource-Allocation Capabilities of this prototype. It is
activated by selecting the [Resource Allocation] menu item from
the [Tutorial] pulldown menu. This command is not yet available
in this version.

Optimization Manager Command

This command walks the user through the tutorial on the
Optimization Manager Capabilities of this prototype. It is
activated by selecting the [Optimization Manager] menu item from
the [Tutorial] pulldown menu. This command is not yet available
in this version.

Respect Command

This command walks the user through the tutorial on the
Respect prototype. The Respect is a prototype that will be
developed by the Real-Time System Requirements and Traceability
effort in the ECS program. It is activated by selecting the
[Respect] menu item from the [Tutorial] pulldown menu. This
command is not yet available in this version.

Mimne Command

This command walks the user through the tutorial on the
Mimne prototype. The Mimne is a prototype that will be developed
by the System Massively Interconnected Processor Prototype effort
in the ECS program. It is activated by selecting the [Mimne]
menu item from the [Tutorial] pulldown menu. This command is not
yet available in this version.

Depend Command

This command walks the user through the tutorial on the
Depend prototype. The Depend is a prototype that will be
developed by the Real-Time Dependable System Design effort in the
ECS program. It is activated by selecting the [Depend] menu item
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from the [Tutorial] pulldown menu. This command is not yet
available in this version.

Teamwork Command

This command walks the user through the tutorial on the
Teamwork CASE tool. Teamwork CASE tool was developed by CADRE
Technologies Incorporated. It is activated by selecting the
[Teamwork] menu item from the [Tutorial] pulldown mer... This
command is not yet available in this version.

STP Command

This command walks the user through the tutorial on the
Software Through Picture (STP) CASE tool. STP CASE tool was
developed by Interactive Development Environment Incorporated.
It is activated by selecting the [STP] menu item from the
[Tutorial] pulldown menu. This command is not yet available in
this version.

SES Command

This command walks the user through the tutorial on the
Scientific Engineering Software (SES) Workbench. SES workbench
was developed by Scientific Engineering Software Incorporated.
It is activated by selecting the [SES] menu item from the
[Tutorial] pulldown menu. This command is not yet available in
this version.

ADAS Command

This command walks the user through the tutorial on the
Architecture Design Assessment System tool. ADAS simulation tool
was developed by Research Triangle Institute (RTI). It is
activated by selecting the [ADAS] menu item from the [Tutorial]
pulldown menu. This command is not yet available in this
version.

PERTS Command

This command walks the user through the tutorial on the
Prototyping Environment for Real-Time Systems (PERTS) tool. This
tool will be developed by the University of Illinois. It is
activated by selecting the [PERTS] menu item from the [Tutorial]
pulldown menu. This command is not yet available in this
version.

ARM Command

This command walks the user through the tutorial on the
Advanced Real-time Monitor (ARM) tool. This tool was developed
by Software Engineering Institute. It is activated by selecting
the (ARM] menu item from the [Tutorial] pulldown menu. This
command is not yet available in this version.
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Network 11.5 Command

This command walks the user through the tutorial on the
Network 11.5 tool. The Network 11.5 simulation tool was
developed by CACI Incorporated. It is activated by selecting the
[Network 11.5] menu item from the [Tutorial] pulldown menu. This
command is not yet available in this version.

Comet Command

This command walks the user through the tutorial on the
Comet tool. The Comet simulation tool was developed by CACI
Incorporated. It is activated by selecting the [Comet] menu item
from the [Tutorial] pulldown menu. This command is not yet
available in this version.

2.3.9 Synthesis Workbench Pulldown Menu

This [Synthesis Workbench] pulldown menu provides a list of
commands to activate the COTS and GOTS tools. This prototype
integrates many of the COTS and GOTS tools to utilize its state-
of-the-art capabilities in conjunction with optimization
capabilities. This pulldown menu consists of the following
commands: Navigation, DESTINATION, Design Optimization, Resource
Allocation, Optimization Manager, Respect, Mimne, Depend,
Teamwork, STP, SES, ADAS, PERTS, ARM, Network 11.5, and Comet.

Navigation Command

This command allows the user to utilize the capabilities
developed by the Navigation prototype. It is activated by
selecting the [Navigation] menu item from the [Synthesis
Workbench] pulldown menu. This command is not yet available in
this version.

DESTINATION Command

This command allows the user to utilize the capabilities
developed by the DESTINATION prototype. It is activated by
selecting the [DESTINATION] menu item from the [Synthesis
Workbench] pulldown menu. This command is not yet available in
this version.

Design Optimization Command

This command allows the user to utilize the capabilities
developed by the Design Optimization prototype. It is activated
by selecting the [Design Optimization] menu item from the
[Synthesis Workbench] pulldown menu. This command is not yet
available in this version.

Resource Allocation Command

This command allows the user to utilize the capabilities
developed by the Resource Allocation prototype. It is activated
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by selecting the (Resource Allocation) menu item from the
[Synthesis Workbench] pulldown menu. This command is not yet
available in this version.

Optimization ManaQer Command

This command allows the user to utilize the capabilities
developed by the Optimization Manager prototype. It is activated
by selecting the [Optimization Manager] menu item from the
(Synthesis Workbench] pulldown menu. This command is not yet
available in this version.

Respect Command

This command allows the user to utilize the capabilities
developed by the Respect prototype. It is activated by selecting
the [Respect] menu item from the [Synthesis Workbench] pulldown
menu. This command is not yet available in this version.

Mimne Command

This command allows the user to utilize the capabilities
developed by the Mimne prototype. It is activated by selecting
the [Mimne] menu item from the [Synthesis Workbench] pulldown
menu. This command is not yet available in this version.

Depend Command

This command allows the user to utilize the capabilities
developed by the Depend prototype. It is activated by selecting
the [Depend] menu item from the [Synthesis Workbench] pulldown
menu. This command is not yet available in this version.

Teamwork Command

This command allows the user to utilize the capabilities¶ developed by the Teamwork CASE tool. It is activated by
selecting the [Teamwork] menu item from the [Synthesis Workbench]
pulldown menu. This command is not yet available in this
version.

STP Command

This command allows the user to utilize the capabilities
developed by the STP CASE tool. It is activated by selecting the
[STP] menu item from the [Synthesis Workbench] pulldown menu.
This command is not yet available in this version.

SES Command

This command allows the user to utilize the capabilities
developed by the SES simulation tool. It is activated by
selecting the [SES] menu item from the [Synthesis Workbench]
pulldown menu. This command is not yet available in this
version.
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ADAS Command

This command allows the user to utilize the capabilities
developed by the ADAS simulation tool. It is activated by
selecting the (ADAS] menu item from the (Synthesis Workbench]
pulldown menu. This command is not yet available in this
version.

PERT Command

This command allows the user to utilize the capabilities
developed by the PERTS tool. It is activated by selecting the
[PERT] menu item from the [Synthesis Workbench] pulldown mcnu.
This command is not yet available in this version.

ARM Command

This command allows the user to utilize the capabilities
developed by the ARM tool. It is activated by selecting the
[ARM] menu item from the [Synthesis Workbench) pulldown menu.
This command is not yet available in this version.

Network 11.5 Command

This command allows the user to utilize the capabilities
developed by the Network 11.5 tool. It is activated by selecting
the (Network II.5] menu item from the (Synthesis Workbench]
pulldown menu. This command is not yet available In this
version.

Comet Command

This command allows the user to utilize the capabilities
developed by the Comet tool. It is activated by selecting the
[Comet] menu item from the [Synthesis Workbench] pulldown menu.
This command is not yet available in this version.

2.3.10 Design Factors Pulldown Menu

The (Design Factors] pulldown menu provides a list of
commands and templates to guide the user in the application of
System Design Factors (refer to the System Design Factors: The
Essential Ingredients of System Desiqn, NSWCDD/TR-92/268 (in
publication), for more information). These templates assist the
user in specifying the goal/criteria to measure and allow the
user to probe this specification to a subsystem, components, an
object, or the whole system. The System Design Factors (SDF)
provide the mechanism to quantify various aspects of the design.
This pulldown menu consists of the following commands: SDF
Template, Taxonomy, Performance, Real-Time, Computation/
Processing Requirements, Dependability, Security, Humanware,
Physical Requirements, Financial Requirements, Time Projected,
Life Cycle, and Future Needs Consideration.
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SDF Template Command

This command provides the templates that guide the user in
specifying the approbpriate goal/criteria that the user wants to
measure. It is activated by selecting the [SDF Template] menu
item from the [Design Factors] pulldown menu. When this command
is activated, the template will appear as shown in Figure 2-12.
The SDF features allow the user to specify the design
goal/criteria either internally during the DESTINATION prototype
session or externally during the Teamwork CASE tool session. In
this version, the SDF features are only available for specifying
during the Teamwork Case tool session.

Taxonomy Command

This command provides the taxonomy of the SDF and the
detailed description of each factor. The detailed description
consists of terminology, definition, source, metrics, example,
usage, and note. The terminology provides the commonly used
vocabulary word. The definition provides the meaning of the
factor. The metrics provide the unit of measurement (dimension)
for the factor. The example provides some illustrations of the
factor. The usage provides the cases when, how, and why, to
apply the factor. Lastly, the note provides the relevant
information or warnings related to the factor. This command is
activated by selecting the [Taxonomy] menu item Zrom the [Design
Factors] pulldown menu. This command is not yet available in
this version.

Performance Command

This command provides the template that guides the user in
specifying the Performance goal/criteria that the user wants to
measure. It is activated by selecting the [Performance] menu
item from the (Design Factors] pulldown menu. When this command
is activated, the Performance template will appear as shown in
the second template in Figure 2-12. The SDF features allow the
user to specify the design goal/criteria either internally,
during DESTINATION prototype session, or externally, during the
Teamwork CASE tool session. In this version, the SDF features
are only available for specifying during the Teamwork Case tool
session.

Real-Time Command

This command provides the template that guides the user in
specifying the Real-Time goal/criteria that the user wants to
measure. It is activated by selecting the [Real-Time] menu item
from the [Design Factors] pulldown menu. When this command is
activated, the Real-Time template will appear as shown in the
second template in Figure 2-12. The SDF features allow the user
to specify the design goal/criteria either internally, during the
DESTINATION prototype session, or externally, during the Teamwork
CASE tool session. In this version, the SDF features are only
available for specifying during the Teamwork Case tool session.
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Computational/Processing Requirements Command

This command provides the template that guides the user in
specifying the Computational/Processing Requirements
goal/criteria that the user wants to measure. It is activated by
selecting the [Computational/Processing Requirements] menu item
from the [Design Factors] pulldown menu. When this command is
activated, the Computational/Processing Requirements template
will appear as shown in the second template in Figure 2-12. The
SDF features allow the user to specify the design goal/criteria
either internally, during the DESTINATION prototype session, or
externally, during the Teamwork CASE tool session. In this
version, the SDF features are only available for specifying
during the Teamwork Case tool session.

Dependability Command

This command provides the template that guides the user in
specifying the Dependability goal/criteria that the user wants to
measure. It is activated by selecting the [Dependability] menu
item from the [Design Factors] pulldown menu. When this command
is activated, the Dependability template will appear as shown in
the second template in Figure 2-12. The SDF features allow the
user to specify the design goal/criteria either internally,
during the DESTINATION prototype session, or externally, during
the Teamwork CASE tool session. In this version, the SDF
features are only available for specifying during the Teamwork
Case tool session.

Security Command

This command provides the template that guides the user in
specifying the Security goal/criteria that the user wants to
measure. It is activated by selecting the [Security] menu item
from the [Design Factors] pulldown menu. When this command is
activated, the Security template will appear as shown in the
second template in Figure 2-12. The SDF features -!low the user
to specify the design goal/criteria either internally, during the
DESTINATION prototype session, or externally, during the Teamwork
CASE tool session. In this version, the SDF features are only
available for specifying during the Teamwork Case tool session.

Humanware Command

This command provides the template that guides the user in
specifying the Humanware goal/criteria that the user wants to
measure. It is activated by selecting the [Humanware] menu item
from the [Design Factors) pulldown menu. When this command is
activated, the Humanware template will appear as shown in the
second template in Figure 2-12. The SDF features allow the user
to specify the design goal/criteria either internally, during the
DESTINATION prototype session, or externally, during the Teamwork
CASE tool session. In this version, the SDF features are only
available for specifying during the Teamwork Case tool sess )n.
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Physical Requirements Command

This command provides the template that guides the user in
specifying the Physical Requirements goal/criteria that the user
wants to measure. It is activated by selecting the (Physical
Requirements] menu item from the [Design Factors] pulldown menu.
When this command is activated, the Physical Requirements
template will appear as shown in the second template in
Figure 2-12. The SDF features allow the user to specify the
design goal/criteria either internally, during the DESTINATION
prototype session, or externally, during the Teamwork CASE tool
session. In this version, the SDF features are only available
for specifying during the Teamwork Case tool session.

Financial Requirements Command

This command provides the template that guides the user in
specifying the Financial Requirements goal/criteria that the user
wants to measure. It is activated by selecting the [Financial
Requirements] menu item from the (Design Factors] pulldown menu.
When this command is activated, the Financial Requirements
template will appear as shown in the second template in
Figure 2-12. The SDF features allow the user to specify the
design goal/criteria either internally, during the DESTINATION
prototype session, or externally, during the Teamwork CASE tool
session. In this version, the SDF features are only available
for specifying during the Teamwork Case tool sessicn.

Time Projected Command

This command provides the template that guides the user in
specifying the Time Projected goal/criteria that the user wants
to measure. It is activated by selecting the [Time Projected]
menu item from the [Design Factors] pulldown menu. When this
command is activated, the Time Projected template will appear as
shown in the second template in Figure 2-12. The SDF features
allow the user to specify the design goal/criteria either
internally, during the DESTINATION prototype session, or
externally, during the Teamwork CASE tool session. In this
version, the SDF features are only available for specifying
during the Teamwork Case tool session.

Life Cycle Command

This command provides the template that guides the user in
specifying the Life Cycle goal/criteria that the user wants to
measure. It is activated by selecting the [Life Cycle] menu item
from the [Design Factors] pulldown menu. When this command is
activated, the Life Cycle template will appear as shown in the
second template in Figure 2-12. The SDF features allow the user
to specify the design goal/criteria either internally, during the
DESTINATION prototype session, or externally, during the Teamwork
CASE tool session. In this version, the SDF features are only
available for specifying during the Teamwork Case tool session.
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Future Needs Consideration Command

This command provides the template that guides the user in
specifying the Future Needs Consideration goal/criteria that the
user wants to measure. It is activated by selecting the [Future
Needs Consideration] menu item from the [Design Factors] pulldown
menu. When this command is activated, the Future Needs
Consideration template will appear as shown in the second
template in Figure 2-12. The SDF features allow the user to
specify the design goal/criteria either internally, during the
DESTINATION prototype session, or externally, during the Teamwork
CASE tool session. In this version, the SDF features are only
available for specifying during the Teamwork Case tool session.

2.3.11 Model Selection Pulldown Menu

The [Model Selection] pulldown menu provides a list of model
choices to be operated by this prototype. This pulldown menu
consists of the following commands: Conceptual, Logical,
Resource, and Implementation.

Conceptual Model Command

This command instructs the DESTINATION prototype in
performing only the operation that relates to the Conceptual
Model. It is activated by selecting the [Conceptual Model] menu
item from the [Model Selection] pulldown menu. This command is
not yet available in this version.

Logical Model Command

This command instructs the DESTINATION prototype in
performing only the operation that relates to the Logical Model.
It is activated by selecting the (Logical Model] menu item from
the [Model Selection] pulldown menu. This command is not yet
available in this version.

Resource Model Command

This command instructs the DESTINATION prototype in
performing only the operation that relates to the Resource Model.
It is activated by selecting the [Resource Model] menu item from
the [Model Selection] pulldown menu. This command is not yet
available in this version.

Implementation Model Command

This command instructs the DESTINATION prototype in
performing only the operation that relates to the Implementation
Model. It is activated by selecting the [Implementation Model]
menu item from the [Model Selection] pulldown menu. This command
is not yet available in this version.
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2.3.12 Extent Selection Pulldown Menu

The (Extent Selection] pulldown menu provides a list of
command choices that select the scope of the system under design.
This pulldown menu consists of the following commands: Full
Design, Partial Design, By Level, By Name, By Selection, By
Selected Area.

Full Design Command

This command indicates that the scope of the complete system
is under design. It is activated by selecting the [Full Design]
menu item from the [Extent Selection] pulldown menu. This
command is not yet available in this version.

Partial Design Command

This command indicates that the scope of the partial system
is under design. It is activated by selecting the (Partial
Design] menu item from the (Extent Selection] pulldown menu.
This command is not yet available in this version.

By Level Command

This command indicates that the scope of the specific level
of the system is under design. It is activated by selecting the
[By Level] menu item from the [Extent Selection] ptlldown menu.
This command is not yet available in this version.

By Name Command

This command indicates that the scope of the specific
component name of the system is under design. It is activated by
selecting the [By Name] menu item from the [Extent Selection]
pulldown menu. This command is not yet available in this
version.

By Selection Command

This command indicates that the scope of the selected
object(s) of the system is under design. It is activated by
selecting the (By Selection] menu item from the (Extent
Selection] pulldown menu. This command is not yet available in
this version.

By Selected Area Command

This commanAd indicates that the scope of the objects in the
selected area is under design. It is activated by selecting the
[By Selected Area] menu item from the [Extent Selection] pulldown
menu. This conimand is not yet available in this version.
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2.3.13 Preferences Pulldown Menu

The [Preferences] pulldown menu provides the commands that
customize the DESTINATION appearance and modes. This pulldown
menu consists of the following commands: Setup Environment and
Save Environment.

SetuR Environment Command

This command provides a cascade menu with a list of commands
to allow the user to set up the environment that is suitable to
the user when DESTINATION is first started. It is activated by
selecting the menu item [Setup Environment] from the
[Preferences] pulldown menu. This includes the looks and feels,
mode, path, model, etc. This command is not yet available in
this version.

Save Environment Command

This command allows the user to save the environment when
the user completes the customization. It is activated by
selecting the menu item [Save Environment) from the [Preferences]
pulldown menu. This command is not yet available in this
version.

2.3.14 Resource Allocation Optimization Pulldown Menu

The [Resource Allocation Optimization] pulldown menu
provides a list of commands to perform allocation of the Logical
Model onto the Resource Model (refer to the DESTINATION Method
and Capabilities for a detailed description). This pulldown menu
consists of the following commands: Objective Function Guidance,
Allocation Algorithm Guidance, Perform Mapping, Assess Mapping,
View Mapping, Display Allocation History, Collect Statistical
Results, Generate Report File, Print Statistical Report, Display
Algorithm Window, Reset Algorithm Window, Close Algorithm Window,
Reconsider All Rejected, Reject From Consideration, Override
Selection, Apply Algorithm Selection Rules, Display Assignment
Window, Reset Assignment Window, Close Assignment Window, Update
Resource Model Utilization, Update Logical Model Utilization,
Display Selected Allocation, Display Allocation List, and
Tailorable Objective Function Prototype.

Objective Function Guidance Command

This command provides the user with a list of objective
functions and guides the user in selecting the proper choice
based on the design goal/criteria that the user specifies. It is
activated by selecting the [Objective Function Guidance] menu
item from the [Resource Allocation Optimization] pulldown menu.
This command is not yet available in this version.
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Allocation Algorithm Guidance Command

This command provides the user with a list of allocation
algorithms and guides the user in selecting the proper choice
based on the design goal/criteria that the user specifies. It is
activated by selecting the [Allocation Algorithm Guidance] menu
item from the [Resource Allocation Optimization] pulldown menu.
This command is not yet available in this version.

Perform Mapping Command

This command obtains the selected objective function in
conjunction with the selected allocation algorithm and applies to
the selected Logical Model and Resource Model for generating the
Implementation Model (allocation) candidate. It is activated by
selecting the [Perform Mapping] menu item from the [Resource
Allocation Optimization] pulldown menu.

Assess Mapping Command

This command evaluates and ranks the latest generated
Implementation Model (allocation) candidate with the previously
generated candidates based on the specific design goal/criteria.
It is activated by selecting the [Assess Mapping) menu item from
the [Resource Allocation Optimization] pulldown menu. This
command is not yet available in this version.

View MappRng Command

This command graphically displays the selected Logical
Model, Resource Model, and Implementation Model (allocatIon). It
is activated by selecting the [View Mapping] menu item from the
[Resource Allocation Optimization] pulldown menu. This command
is not yet available in this version.

Display Allocation History Command

This command displays the lists, ranks, and measures of
effectiveness of all the generated Implementation Model
(allocations) candidates recorded in the Allocation History file.
It is activated by selecting the [Display Allocation History]
menu item from the [Resource Allocation Optimization] pulldown
menu. This command is not yet available in this version.

Collect Statistical Results Command

This command provides a cascade menu with a list of
statistical commands to probe and record results of generated
Implementation Model (allocation) candidates. It is activated by
selecting the [Collect Statistical Results] menu item from the
[Resource Allocation Optimization] pulldown menu. This command
is not yet available in this version.
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Generate Report File Command

This command provides a template to the user for specifying
the type of report and information in the report to be generated
for the selected Logical Model, Resource Model, and
Implementation Model (allocation). It is activated by selecting
the (Generate Report File] menu item from the [Resource
Allocation Optimization] pulldown menu. This command is not yet
available in this version.

Print Statistical Report Command

This command provides a template to the user for specifying
the types of reports to be printed for the selected Logical
Model, Resource Model, and Implementation Model (allocation). It
is activated by selecting the (Print Statistical Report] menu
item from the [Resource Allocation Optimization] pulldown menu.
This command is not yet available in this version.

Display Algorithm Window Command

This command displays the Algorithm window. It is activated
by selecting the (Display Algorithm Window] menu item from the
[Resource Allocation Optimization] pulldown menu.

Reset Algorithm Window Command

This command resets the Algorithm window to its initial
contents. It is activated by selecting the [Reset Algorithm
Window] menu item from the [Resource Allocation Optimization]
pulldown menu. This command is not yet available in this
version.

Close Algorithm Window Command

This command closes the Algorithm window. It is activated
by selecting the [Close Algorithm Window] menu item from the
[Resource Allocation Optimization] pulldown menu.

Reconsider All Rejected Command

This command places the rejected objective functions and the
allocation algozithms from the Rejected selection scroll list
back to the Consideration selection scroll list. It is activated
by selecting the [Reconsider All Rejected] menu item from the
[Resource Allocation Optimization] pulldown menu. This command
is not yet available in this version.

Reject From Consideration Command

This command places the selected objective functions and
selected allocation algorithms from the Consideration selection
scroll list to the Rejection selection scroll list. It is
activated by selecting the [Reject From Consideration] menu item
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from the [Resource Allocation Optimization] pulldown menu. This
command is not yet available in this version.

Override Selection Command

This command allows the user to override the recommended
objective function and allocation algorithm. It is activated by
selecting the [Override Selection] menu item from the [Resource
Allocation Optimization] pulldown menu. This command is not yet
available in this version.

Anply Algorithm Selection Rules Command

This command activates the selected classes of algorithm
selection rules to reject unsuitable classes of algorithms and
determines the uost suitable algorithm to optimize the system
under design. It is activated by selecting the [Apply Algorithm
Selection Rules] menu item from the [Resource Allocation
Optimization] pulldown menu. This command is not yet available
in this version.

Display Assignment Window Command

This command displays the Logical and Resource model
assignment window and allows the user to graphically specify the
initial allocation or the allocation's constraint to the selected
Logical Model, and Resource Model. It is activated by selecting
the [Display Assignment Window] menu item from the [Resource
Allocation Optimization] pulldown menu. This command is not yet
available in this version.

Reset Assignment Window Command

This command graphically resets the assignment of the
Logical and Resource Model to the nonmapping assignment. It is
activated by selecting the [Reset Assignment Window] menu item
from the [Resource Allocation Optimization] pulldown menu. This
command is not yet available in this version.

Close Assignment Window Command

This command closes the assignment window. It is activated
by selecting the [Close Assignment Window] menu item from the
[Resource Allocation optimization] pulldown menu. This command
is not yet available in this version.

Update Resource Model Utilization Command

This command provides the bar chart update of the Resource
Model Utilization. It is activated by selecting the [Update
Resource Model Utilization] menu item from the [Resource
Allocation Optimization] pulldown menu. This command is not yet
available in this version.
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Update Logical Model Utilization Command

This command provides the bar chart update of the Logical
Model Utilization. It is activated by selecting the [Update
Logical Model Utilization] menu item from the [Resource
Allocation Optimization] pulldown menu. This command is not yet
available in this version.

Displav Selected Allocation Command

This command graphically displays the selected
Implementation Model (allocation) candidate. It is activated by
selecting the [Display Selected Allocation] menu item from the
[Resource Allocation Optimization] pulldown menu. This command
is not yet available in this version.

Display Allocation List Command

This command provides the list of Implementation Model
(allocation) candidates. It is activated by selecting the
[Display Allocation List] menu item from the [Resource Allocation
Optimization] pulldown menu. This command is not yet available
in this version.

Tailorable Objective Function Prototype Command

This command provides a series of templates (shown in
Figure 2-13) and choices that allow the user to customize the
single criteria or multicriteria objective function based on the
user's specific design goal/criteria or needs. It is activated
by selecting the [Tailorable Objective Function Prototype] menu
item from the [Resource Allocation Optimization] pulldown menu.

2.3.15 Design Structuring Optimization Pulldown Menu

The [Design Structuring Optimization] pulldown menu provides
a list of commands to structure the design (refer to the
DESTINATION Methodology and Capabilities technical report for a
more detailed description). This pulldown menu consists of the
following commands: Perform Partition, Perform Fragmentation,
Perform Decomposition, Perform Recomposition, and Perform Code
Generation.

Perform Partition Command

This command allows the user to partition the conceptual
model into the Logical Model, Resource Model, and Implementation
Model. It is activated by selecting the (Perform Partition] menu
item from the [Design Structuring Optimization] pulldown menu.
This command is not yet available in this version.
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Perform Fracgmentation Command

This command allows the user to fragment a design into
multiple designs within the same level of design. It is activated
by selecting the [Perform Fragmentation] menu item from the
[Design Structuring Optimization] pulldown menu. This command is
not yet available in this version.

Perform Decomposition Command

This command allows the user to decompose one level of
design into multiple levels of design. It is activated by
selecting the [Perform Decomposition] menu item from the [Design
Structuring Optimization] pulldown menu. This command is not yet
available in this version.

Perform Recomposition Command

This command allows the user to recompose multiple levels of
design back to one level of design in conjunction with
recomposing multiple fragments of the designs back to one design.
It is activated by selecting the [Perform Recomposition] menu
item from the [Design Structuring Optimization] pulldown menu.
This command is not yet available in this version.

Perform Code Generation Command

This command provides a template that allows the user to
select the logical design or logical component and to specify the
programming language, programming structure, target machine, and
other necessary information for generating code for that
particular piece of design. It is activated by selecting the
(Perform Code Generation] menu item from the [Design Structuring
Optimization] pulldown menu. This command is not yet available
in this version.

2.3.16 Optimization Manager Pulldown Menu

The [Optimization Manager] pulldown menu provides commands
to characterize and quantify the logical, resource, and
implementation models (refer to the DESTINATION Methodology and
Capabilities for detailed information). It assists the user in
making trade-offs and in incorporating design rules into its
knowledge base. This pulldown menu consists of the following
commands: Reset Characterization Window, Display Characterization
Window, Close Characterization Window, Perform Logical Model
Quantitative Characterization, Perform Logical Model Qualitative
Characterization, Perform Resource Model Quantitative
Characterization, Perform Resource Model Qualitative
Characterization, Perform Overall Model Quantitative
Characterization, Perform Overall Model Qualitative
Characterization, Trade-off Analysis, Trade-off Recommendation,
Guidance, and Deposit System Design Rules.
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Reset Characterization Window Command

This command resets the value in the characterization window
to zero and null. It is activated by selecting the [Reset
Characterization Window] menu item from the [Optimization
Manager] pulldown menu. This command is not yet available in
this version.

Display Characterizatirrn Window Command

This command displays the characterization window. It is
activated by selecting the [Display Characterization Window] menu
item from the (Optimization Manager] pulldown menu.

Close Characterization Window Command

This command closes the characterization window. It is
activated by selecting the [Close Characterization Window] menu
item from the [Optimization Manager] pulldown menu.

Perform Logical Model Quantitative Characterization Command

This command characterizes the Logical Model quantitatively.
It is activated by selecting the [Perform Logical Model
Quantitative Characterization] menu item from the [Optimization
Manager] pulldown menu. When this command is activated, the
Logical Model Quantitative Characterization window appears as
shown in Figure 2-14.

Perform Logical Model Qualitative Characterization Command

This command characterizes the Logical Model qualitatively.
It is activated by selecting the [Perform Logical Model
Qualitative Characterization] menu item from the [Optimization
Manager] pulldown menu. When this command is activated, the
Logical Model Qualitative Characterization window will appear as
shown in Figure 2-14.

Perform Resource Model Ouantitative Characterization Command

This command characterizes the Resource Model
quantitatively. It is activated by selecting the [Perform
Resource Model Quantitative Characterization] menu item from the
[Optimization Manager] pulldown menu. When this command is
activated, the Resource Model Quantitative Characterization
window will appear as shown in Figure 2-14.

Perform Resource Model qualitative Characterization Command

This command characterizes the Resource Model qualitatively.
It is activated by selecting the (Perform Resource Model
Qualitative Characterization] menu item from the [Optimization
Manager] pulldown menu. When this command is activated, the
Resource Model Qualitative Characterization window will appear as
shown in Figure 2-14.
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Perform Overall Model quantitative Characterization Command

This command characterizes the Overall Model quantitatively.
It is activated by selecting the [Perform Overall Model
Quantitative Characterization] menu item from the [Optimization
Manager] pulldown menu. When this command is activated, the
Overall Model Quantitative Characterization window will appear as
shown in Figure 2-14.

Perform Overall Model Oualitative Characterization Command

This command characterizes the Overall Model qualitatively.
It is activated by selecting the [Perform Overall Model
Qualitative Characterization] menu item from the [Optimization
Manager] pulldown menu. When this command is activated, the
Overall Model Qualitative Characterization window will appear as
shown in Figure 2-14.

Trade-off Analysis

This command provides a cascade menu with a list of commands
to allow the user to perform various types of Trade-off Analyses.
It is activated by selecting the [Trade-off Analysis] menu item
from the [Optimization Manager] pulldown menu. This command is
not yet available in this version.

Trade-off Recommendation

This command provides the user with SDF templates and
recommends the user vary certain design goal/criteria or
recommends certain design decisions to obtain the optimal
solution. It is activated by selecting the [Trade-off
Recommendation] menu item from the [Optimization Manager]
pulldown menu. This command is not yet available in this
version.

Guidance

This command provides a cascade menu with a list of commands
to guide the user from one phase to the next, from one level to
the next, or from one component of design to the next. It is
activated by selecting the [Guidance] menu item from the
[optimization Manager] pulldown menu. This command is not yet
available in this version.

Deposit System Design Rules

This command allows the user to deposit the design rules
into the Design Rules Knowledge Base. The Design Rules are used
to enforce the design and the consistency, to verify the
correctness, to validate the design, to provide guidance, and to
provide recommendations. It is activated by selecting the
[Deposit System Design Rules] menu item from the (optimization
Manager] pulldown menu. This command is not yet available in
this version.
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2.3.17 Quit

The command Quit allows the user to leave the application
software DESTINATION.

When the user clicks on the button [Quit] of the main
SYNTHESIS window, the whole application software DESTINATION will
stop executing and all DESTINATION windows will be closed.
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CHAPTER 3

CURRENT STATUS

The development of the DESTINATION prototype Level I has
been primarily focused on the following areas: DESTINATION
Framework and Layout, DESTINATION Interface Specification (DIS),
System Design Factors (SDF), Tailorable Objective Function,
Initial Resource Allocation Algorithm, Allocation CASE Tool
(Teamwork) Interface, Knowledged Base (CLIPS) Interface, other
state-of-the-art toolset (ART), and necessary basic building
features.

Although the SDF features allow the user to specify the
design goal/criteria either internally, during the DESTINATION
prototype session, or externally, during the Teamwork CASE tool
session, these features are only available for the latter case in
the current version.

Although many features have been integrated, the DESTINATION
prototype Level I is still far too immature for external or
public release. However, the prototype Level I will be available
for an ECS internal verification and validation.

3-1/3-2



NSWCDD/TR-92/372

CHAPTER 4

FUTURE PLANS AND DIRECTIONS

The DESTINATION prototype Level I, version 0.5, is part of
the total system design synthesis process. It shows much promise
for the optimization of system designs and the identification of
system design risks. While this work is being completed, some
portions of the prototype have been implemented and tested. Some
other portions have not been implemented or have not yet been
defined. Due to the lessons learned and the experience gained
during the development of this version, the future version will
include interfaces to more standardized graphics systems and
relational data bases and will have enhanced message-handling
capabilities.

The future plan for DESTINATION prototype Level II will
include: testing, verification, and validation of prototype
Level I for refinement and enhancement. Some of the new features
in prototype Level II will include the DESTINATION to Teamwork
CASE Export capability, enhanced features of Design Structuring
capabilities, enhanced features of the Resource Allocation
capabilities, enhanced features of the Optimization Manager,
enhanced features of the Tailorable Objective Functions, enhanced
features of the Resource Allocation Algorithm, enhanced features
of the SDF Specification, initial features of the design rules
knowledge base, initial features of the simulation interface,
initial features of the Resources Model Capture from Teamwork,
and initial integration with PERTS.
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GLOSSARY

Button--A button item is displayed as a labeled box that is mouse
sensitive. Selecting a button will cause a specific action to
occur such as displaying another box or performing a process.
This action will occur each time the button is selected.

"Confirmation" Box--A box on the screen in which information
about directory and file(s) is either displayed or entered. The
"Confirmation" box allows the user to either confirm the deletion
of a directory or file(s) or enter a new file for renaming
purposes. The box consists of the following items: (1) a box
title "Confirmation", (2) two text label lines for displaying
messages, (3) a key-in box for either directory ox file(s), and
(4) two push buttons (or simply buttons): [OK) and (QUIT]. See
Figure 2-5 in subsection "Rename" and Figure 2-8 in subsection
"Delete Directory" of Section 2.3.2.

EPOCH--EPOCH is a modified version of the text editor GNU Emacs
software. EPOCH software will create two windows by default, one
for the Minibuffer and one for the initial Editor buffer.

"File and Directory" Dialog Box--A box on the screen in which
information about path name, file name, and file extension is
either displayed or entered. The dialog box allows the user to
get into the desired directory and select the desired file(s).
The dialog box consists of the following items: (1) a box title
"File and Directory;" (2) a text label line for displaying a
message; (3) three key-in boxes: path name, file name, and file
extension; (4) scroll bars; (5) two scroll selection lists: files
and directories; and (6) two push buttons (or simply buttons):
[OK] and [QUIT]. See Figure 2-3 in subsection "Open" of
Section 2.3.2.

"HelD" Box--A box on the screen in which help information about
DESTINATION and its commands is displayed only. The box consists
of the following items: (1) a box title "Help," (2) a scroll text
display for displaying help information, and (3) a push button,
[OK]. See Figure 2-10 in subsection "Index" and Figure 2-11 in
subsection "Commands" of Section 2.3.5.
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GLOSSARY (Continued)

"Index/Commands" Box--A box on the screen in which a list of all
the commands used in DESTINATION is displayed so that the user
can select a particular command. The box consists of the
following items: (1) a box title, "Index/Commands;" (2) a scroll
selection list of all the commands used in DESTINATION; and (3) a
push button, [CLOSE]. See Figure 2-10 in subsection "Index" and
Figure 2-11 in subsection "Commands" of Section 2.3.5.

Key-in Box--A key-in box item displays a single line of editable
text for obtaining data from the user. A key-in box title may be
displayed to the left of the key-in box. The user must move the
mouse cursor into the key-in box before entering data. Editing
is terminated when the user moves the mouse cursor outside of the
key-in box, or presses an <enter>.

"Message" Box--A box on the screen in which only a warning
message is displayed. The "Message" box is used to notify the
user that the user has attempted to do something incorrectly.
The box consists of the following items: (1) a box title,
"Message;" (2) three text label lines for displaying warning
messages; and (3) a push button, (QUIT]. See Figures A-l, A-2,
and A-3 in Appendix A.

MOTIF--MOTIF is a library of interface elements that are
available to the user.

Pulldown Menu--A pulldown menu is a labeled box which, when
selected, causes a menu of choices to be displayed below the box.
Each of the choices is called a menu item. A menu item is
selected either by dragging the mouse cursor over these choices
and then releasing the mouse button at the chosen menu item or by
moving the mouse cursor into the chosen menu item and then
clicking on it.

Push Button--See Button.

Scroll Bar--Scroll bars allow the user to view data that is too
large to be displayed at one time. Most text label items and
scroll list items of a box have both a vertical scroll bar for
scrolling up and down and a horizontal scroll bar for scrolling
from side to side.

Scroll List--A scroll list can be a scrollable list of text
choices (scroll selection list) or a scrollable displayed text
(scroll text display).

Scroll Selection List--A scroll selection list is a scrollable
list of text choices. The user may select a new value for the
item by scrolling the list to the desired choice, and then
clicking on the chosen item.
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GLOSSARY (Continued)

Scroll Text Dis~lay--A scroll text display displays large amounts
of text in a scrollable box. The user may view the text but may
not edit or select it.

"Source and Destination" Dialog Box--A box on the screen in which
information about the path name, file name, and file extension of
the source part and the destination part is either displayed or
entered. The dialog box allows the user to get into the desired
directories and select the desired files. The dialog box
contains two parts (each part functions in the same way as the
"File and Directory" dialog box): the source information on the
left side and the destination information on the right side. See
Figure 2-7 in subsection "Copy" of Section 2.3.2.

TAE+--TAE+ (Transportable Applications Environment Plus) is an
integrated environment for developing and running graphical,
window-based application systems.

Text Label--A text label is a nonselectable text that is used for
displaying messages only.

Window--Windows occupy sections of the screen and can overlap one
another. A window frames its contents. The contents can be
buttons, a pulldown menu, or boxes. Most windows can be moved,
changed in size, scrolled, and closed.

X Window--X Window (or X) is a network-based window-ing system
that is independent of the hardware and the operating system. X
allows applications to diaw pictures as well as text.
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APPENDIX A

ERROR HANDLING

1. The user is restricted to selecting the [System Engineering
Activity] pulldown menu as the first step of operating the
SYNTHESIS window. If another button is selected before the
(System Engineering Activity] pulldown menu, the selected button
will not be activated and the message "This button is not
activated unless you select the button [System Engineering
Activity] first!" will appear in the "Message" box (see
Figure A-l). This message is acknowledged by click-ing on the
button (OKI of the "Message" box before proceeding.

2. The user can change the directory either by selecting the new
directory name from the scroll selection list Directories or by
editing the key-in box "Path" of the "File and Directory" dialog
box or the "Source and Destination" dialog box. However, if the
directory is reversed with the intention to pass the root, the
message "Sorry, you cannot pass root of the path!" will appear in
the "Message" box (see Figure A-2). Again, this message is
acknowledged by clicking on the button [OK) of the "Message" box.

3. Any selection of SEA phase besides phase "Other" forces the
user to perform the operation within that selected SEA phase; and
any file created within a SEA phase will have a file extension
that corresponds to the SEA phase in which it was created.
Therefore, when the user changes the key-in box "Extension," the
"Message" box with the message "Sorry, you cannot change value of
the extension!" will appear (see Figure A-3). The "Message" box
can be destroyed by clicking on its button [OK]. In order to
edit the key-in box "Extension," the user must reselect SEA phase
"Other" from the [System Engineering Activity] pulldown menu.
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